KANSAS COMPREHENSIVE TRANSPORTATION PROGRAM
Planned. Executed. Delivered.

Celebrating the CTP
See pages 2, 8-13

Inside...
◆ K-61 expansion marks two significant milestones
◆ Flume saves money, materials
◆ Byways offer uniquely Kansas experience
◆ Partnership to benefit environment, businesses
◆ Public Transit projects receive stimulus grants
By Secretary Deb Miller

CTP accomplishments won’t soon be forgotten

It’s fair to say that I’ve forgotten a lot more about the year 1999 than I can remember.

It required a visit to Wikipedia to remind me that 1999 was the year the Dow Jones index finished above 10,000 for the first time (when will we see that again?). I was unaware that 1999 was the year the Roth IRA was introduced. And I had forgotten that 1999 was the year Haysville was devastated by an F4 tornado and that K-State quarterback Michael Bishop was drafted by the New England Patriots.

But one of the things I clearly remember about 1999, even though I wasn’t at KDOT at the time, is that Gov. Bill Graves signed legislation authorizing the Comprehensive Transportation Program (CTP) that year. What a momentous occasion it was for Kansas, our economy and KDOT.

In this issue of Translines there are a number of stories and photos that review the work of the past decade and the great things we have done to improve the Kansas transportation system. I certainly don’t need any reminders of the difficulties we have had to overcome to get to the point we are. In April we let the last major CTP project – the K-61 expansion in McPherson County.

Thinking back on those difficulties, I’m amazed we’ve actually gotten to the point this month that we are celebrating the successful completion of the CTP. While construction will continue for the next couple years on some CTP projects, all the major projects have now been let.

Almost from the beginning there were issues with the funding that intensified during the recession of 2002 to 2003. We restructured the funding package and thought we were out of the woods. But a few years later Hurricane Katrina blew in from the Gulf, devastating southern Louisiana and Mississippi and driving up the cost of construction materials throughout the nation.

And just when we thought we’d gotten over that hurdle, we were pulled into the current recession.

The roadblocks in front of the agency have been formidable, but we’ve managed to get around them by showing an amazing resolve to find ways to keep the program moving forward. Not only did we have to be competent and credible in terms of designing and delivering the program, we had to be resourceful, flexible and creative.

To be where we are today is just unbelievable to me in so many ways. There were many opportunities for us to not be where we are. So I’m happily stunned that we’ve made it.

This summer and fall there will be CTP celebrations in all of our districts and Headquarters and I hope you can attend your event. We have a lot to be proud of and it’s worth taking some time, even if you can’t be at the celebrations, to consider what we have built and how much our fellow Kansans count on us.

Even if most of 1999 is just a blur to me at this point in my life, I won’t ever forget how important that year was for KDOT and Kansas transportation.

One more thing I learned from Wikipedia: 1999 was the year the TV series SpongeBob SquarePants aired its first episode. How could I have forgotten that!

Calendar of Events

June 12 – 9:30 a.m. - Highway Advisory Commission meeting.

June 13 - Employees’ Council softball tournament, Rueger Park, Topeka. For more information, contact Eric Idol, 785-296-6705.

June 17 – 1 p.m. Construction bid letting, Fourth Floor, West Wing, Eisenhower State Office Building.

July 3 – State employees off for Independence Day holiday.
K-61 expansion marks two significant milestones

The four-lane construction of K-61 between Hutchinson and McPherson marks two significant milestones for KDOT – the end of the Comprehensive Transportation Program (CTP) and the beginning of major economic stimulus funding.

“The expansion of K-61 from Hutchinson to McPherson was the last remaining major CTP project not let to construction,” said Secretary Deb Miller. “This project was temporarily removed from our letting schedule and without the American Recovery and Reinvestment Act (ARRA) funds, completing this commitment would not have been possible.”

In February, CTP funding was used to let work for the expansion of K-61 in Reno County. Koss Construction of Topeka was awarded a $41.1 million contract for the work. However, to construct the work in both counties, an infusion of ARRA funding was necessary.

“The K-61 expansion is one of five stimulus projects in Kansas that will help create thousands of jobs, enhance motorist safety and support economic development,” said KDOT Deputy Secretary Jerry Younger.

Koss was also awarded the McPherson County work with $64.2 million in ARRA funds. Total construction cost for the four-lane expansion was $105.3 million. The entire 23.1-mile project is tentatively scheduled to be completed in early 2012.

“The low bid on K-61 came in 27 percent under the $88 million estimate,” said Younger. “The extra funds will be applied to the initial phase of a stimulus project expanding K-18 to four lanes between Fort Riley and Manhattan.”

More than 10,000 jobs will be created or sustained in Kansas from economic stimulus projects. The K-61 work alone is estimated to support more than 2,900 jobs and generate $220 million in annual economic output during construction.

Kansas was awarded $378 million under the ARRA, with $348 million dedicated for road and bridge work and the remaining $30 million to be used for transit projects. Future economic stimulus projects include:
• $91 million for U.S. 69 in Overland Park for the corridor from I-35 to 103rd Street to address congestion issues and support economic development. Bids were accepted May 20 for this project.
• $11 million for K-23 in Gove County to enhance safety on 16 miles of a narrow, 50-year-old road that lacks shoulders and has steep side slopes. Most of the traffic on this stretch are trucks hauling agricultural commodities and implements. Bids were also accepted in May for this project.
• $23 million for I-135/47th Street in Wichita for the reconstruction and upgrade of the interchange to remove a bottleneck and to provide a link to an underutilized area. Bids will be accepted in July for this project.
• The initial phase of expanding K-18 between Fort Riley and Manhattan to four lanes. KDOT hopes to accept bids on this project in late spring of 2010, but no firm date for a construction letting has been set. – **S.W**
Flume saves money, materials

By Priscilla Petersen
District Four Public Affairs Manager

The KDOT Pittsburg Area Crew has built an edge drain flume that recycles material and saves money.

The form for the flume consists of leftover plywood that is lined with surplus aluminum signs. The District Four Shop constructed the center block-out from aluminum. At the suggestion of the Altamont Subarea crew, a narrow slot was added on top of the casting to hold a “varmint screen” in place so it can’t be lost or washed away.

Area Crew Supervisor Joe Engle noted the cost of concrete is around $20 a unit. This has resulted in a substantial savings since the local vendor charges $80 for each edge drain flume. The crew has made eight forms, and as time permits plans to build around 25 units to replace aging and broken edge drain flumes along area highways.

“We’re trying to do our part to help out during tough financial times,” Engle explained.

ASCE honors KDOT

At left, Robert W. Stokes, Kansas State University Professor and American Society of Civil Engineers (ASCE) Region 7 Director, presents the Superior Employer Recognition Award to Secretary Deb Miller from the ASCE, Committee on Younger Members. Also pictured is Deputy Secretary Jerry Younger and Howard Lubliner, Road Design Leader. Miller accepted the award on behalf of KDOT, which was honored because of outstanding training and professional development opportunities the agency offers such as tuition assistance, training classes, hands-on learning experiences, internship program, rotational training program and progression tracts. KDOT is the first public agency to ever receive this national award.
KDOT Computer Training – from the KCTC

Increase your efficiency!

Focus on Word
Should I make a table or a form?
Pros and Cons of tables vs. forms:
Tables pro: Tables are easy to create. Con: Tables allow people to type anywhere.
Forms pro: Users can only click & type in fields (areas designated for typing). It’s easy for the user to fill out a form. Con: You need to know how to display the Developer tab in the Ribbon and protect a document to create a true form. Here’s how:
Creating a table: 1) Click on the Insert tab 2) Click Table 3) A grid appears. Hover your mouse over the grid – you will see a preview of a table in your Word document 4) Click on the grid to insert the table
Creating a form: 1) Display the Developer tab (if necessary) Click the Office button, Click the Word Options button and Check Show Developer Tab in the Ribbon 2) Insert fields: In the Controls section of the Developer tab, click on the button for the type of form field you want to insert: Text allows users to type anything, Combo Box creates a drop down list, Date Picker (New in 2007) lets users select a date from a calendar and Legacy Tools displays a menu of tools from Word 2003 (you have to click the Legacy Tools button to insert a Check Box) 3) Protect the form: Click Protect Document, Click Restrict Formatting & Editing, Click Allow only this type of editing in the document, From the dropdown list, select Filling in Forms Click Yes Start Enforcing Protection.

Check out the shared calendar: KCTC for on-going classes. Contact the KCTC at kctc@ksdot.org or call Ingrid Vandervort 785-296-8993.

Artist Stan Herd to promote Kansas Scenic Byways

A unique public-private initiative that promotes nature, the arts, tourism and even luck was announced May 21.

Kansas artist Stan Herd, best known for his earthwork art, has teamed with the Kansas departments of Transportation and Commerce and the Kansas Lottery to promote the state’s nine scenic byways. He has created paintings of scenes along each byway and will visit byways communities this summer and fall to promote the initiative. The original Herd paintings will also be grand prizes in a new lottery instant scratch game called Painted Byways.

More information on this initiative will be available in the July edition of Translines.

Experience the Flint Hills signs installed

The second phase of an effort to raise awareness of the Flint Hills natural beauty has been completed with the installation of 25 “Experience the Flint Hills” signs throughout the scenic region.

KDOT worked with the Flint Hills Tourism Coalition to determine the best locations to place the signs, according to KDOT Environmental Scientist Scott Shields. The Coalition is an alliance of tourism marketing agencies from the 22 Flint Hills counties along with Flint Hills Resource Conservation and Development and the Kansas Division of Tourism.

“The initial phase of the project was construction of four Welcome to the Flints Hills Monuments on I-70 and I-35,” said Shields. “The 25 signs were placed at locations we believe will have an optimal visual impact for motorists to encourage travel and tourism.”

The monuments were installed in 2007 on I-70 near Maple Hill and Junction City and on the Kansas Turnpike near Emporia and Cassody. The signs were installed in approximately a 200-mile area of the Flint Hills beginning in KDOT District One and extending through Districts Two, Four and Five.

Transportation enhancement funds administered through KDOT were used for the monuments and signs. You can learn more about the Kansas Flint Hills at www.kansasflinthills.travel – S.W.
A public-private partnership to promote clean roadsides and environmentally-conscious businesses was recently announced by KDOT.

The agency has entered into an agreement with Adopt A Highway Maintenance Corporation to establish the first Sponsor-A-Highway Program in Kansas. The program, which is operating in about 20 states, will complement the well-established and successful Adopt-A-Highway Program, a volunteer initiative to pick up litter along roadsides three times a year.

The litter collectors in the Sponsor-A-Highway Program will be paid workers who will be on specific stretches of highway in the Topeka and Lawrence areas 12 times or more a year. The company will also oversee a program in the Wichita area.

The cost of the litter pick-up will be covered by business sponsors, who will have their names and company logos placed on signs in the one-mile sponsorship segments. The sponsors will be solicited by Adopt A Highway Maintenance Corporation.

“This is a great way to improve the appearance of our highways and an opportunity for businesses to help build their image as engaged, environmentally-friendly members of the community,” said Deputy Secretary Jerry Younger. “And, it will be a cost-saver for KDOT by freeing our crews to perform other important maintenance work.”

Patricia Nelson, Vice President of the Adopt A Highway Maintenance Corporation said the program is popular in other states.

“This unique program represents a true win-win for all involved,” Nelson said. “The state is provided privately-funded litter removal on its busiest roadways and sponsors are recognized on signs as business leaders who give back to their community and customers.”

KDOT has outlined plans to distribute public transit funding made available for economic stimulus through the American Recovery and Reinvestment Act of 2009 (ARRA).

The state expects to receive about $30 million in ARRA transit funds, divided into rural and urban categories. The Federal Transit Administration (FTA) will distribute $16 million directly to urban transit providers that serve areas with populations of 50,000 or more. Based on a formula from the FTA, KDOT expects the ARRA transit funding to create or sustain about 840 jobs.

Of the remaining $14 million for rural transit, KDOT will fund grants to 10 rural public transit providers, assist the Topeka and Lawrence transit agencies, upgrade 15 radio towers used by transit agencies and provide for a future intercity bus service.

About $835,000 will be held in reserve in case some of the purchase or project costs were underestimated.

More details about the ARRA public transit applications and grants can be found online at www.ksdot.org/Economic_Recovery/
Have you ever considered exploring one of Kansas’ Scenic Byways as a budget conscious day or weekend getaway?


My favorite is the Flint Hills National Scenic Byway. I have to be honest, the reason it’s my favorite is that it’s the only one I’m familiar with.

Designated a Kansas scenic byway in June 1995, the 47-mile-long byway follows K-177 from Council Grove to Cassoday and cuts through the heart of the Flint Hills. Designated a National Scenic Byway in September of 2005, the prominent feature on the byway is the tallgrass prairie.

The tallgrass prairie originally stretched across central North America from Texas into Manitoba, Canada. In the U.S., it spanned portions of 11 Midwestern states, and The Nature Conservancy has estimated it once covered more than 142 million acres, or about 7.5 percent of the surface area of the lower 48. The tallgrass prairie was so named because some of the grass species found in it were capable of growing to heights of 10 feet, with average heights of six to eight feet very common. It would have been one of the first landscapes encountered by early settlers headed west, and the vast expanse of tallgrass was surely an intimidating sight.

Unfortunately for the tallgrass prairie, the underlying soils were very fertile and over time most of it was plowed under and converted to farm ground. It is now one of the most endangered ecosystems in North America, and The Nature Conservancy has estimated that less than 10 percent of it remains. Currently, large unbroken tracts only exist in the Flint Hills of northern Oklahoma and central Kansas, where the shallow layers of rock have protected it from the plow.

In Kansas we tend to take the Flint Hills for granted because they comprise a large portion of the state, but many consider them a true national treasure because they are the last stronghold of the tallgrass prairie!

From a historical perspective, the Tallgrass Prairie National Preserve, located two miles north of Strong City, is one of the more significant properties on the byway. Initially created in 1996, the 10,894-acre property is unique among national preserves in both its dual ownership and the ecosystem it represents. The National Park Service, The Nature Conservancy, and the Kansas Park Trust work together to manage the preserve and educate the public about the Tallgrass Prairie National Preserve.

The 1880s era ranch headquarters area is a great example of an intact, fully functional 19th century ranch. The remaining 10,000-plus acres of the preserve emphasize the importance of preserving/enhancing the tallgrass prairie. This portion of the preserve is a nearly pristine example of an intact prairie that is much the same today as it was hundreds of years ago.

The preserve offers living weekends, prairie bus tours, self-guided tours of the ranch headquarters, and currently has five maintained hiking trails. In 2007 it was named one of the Eight Wonders of Kansas.

A more modern experience with an emphasis on the scenic nature of the byway can be found in the town of Cassoday, which hosts a Bike Run the first Sunday of each month, March through November.

Cassoday’s population is normally about 125, but during bike runs it has been known to swell to more than 5,000. I have never been to the Bike Run, but I understand there is good food, hundreds of awesome motorcycles on display and numerous vendor booths to visit. A ride through the scenic Flint Hills followed by breakfast/brunch must be appealing because this popular event continues to grow every year.

For a uniquely Kansas experience, grab a cooler, the kids and go for a drive on one of the state’s scenic byways. For more information on Kansas byways go to www.ksbyways.org.

Joe Palic is the Area Engineer at Marion.
Celebrating 10 years of the Comprehensive Transportation Program

Excerpt from the May 1999 Translines

New 10-year CTP approved

State lawmakers gave final approval to a new Comprehensive Transportation Program on Friday, April 30, 1999. That afternoon, House Bill 2071 passed the House on a vote of 89 to 35. Two days earlier, it had cleared the Senate on a vote of 30 to 9. (As an historical footnote, House passage came on the 10th anniversary of the vote that approved the Comprehensive Highway Program in 1989.)

The $12.9 billion, ten-year CTP is the largest public works program in the history of Kansas. It provides $2.65 billion dollars in additional resources to KDOT. The legislature also authorized 108 new positions for KDOT to give us the bodies needed to get the program done. Secretary of Transportation E. Dean Carlson called HB 2071 “an excellent bill,” he said. “I am looking forward to implementing the program that will benefit all Kansans.”

“A major factor to the success of the CTP was the dedication of the KDOT and contractor’s employees to quality. The KDOT employees should be proud of this major accomplishment due to its complexity and aggressive schedule. As usual they rose to the occasion and produced.”

Mike Crow
retired Director of Planning and Development

A few highlights during the Comprehensive Transportation Program

- **August 1999**: First two CTP projects let (grading on U.S. 81; surface rehab on K-383)
- **August 2000**: New SE projects announced
- **August 2001**: U.S. 169 ground breaking ceremony
- **February 2004**: Transportation revolving fund begins
- **April 2004**: Sink hole bridge demolished on I-70
- **December 2004**: I-635/I-70 interchange complete

- **April 1999**: CTP approved, began July 1
- **August 2000**: New SE projects announced
- **September 2002**: Four-laning U.S. 81 complete
- **April 2004**: CTP funding package revamped
- **July 2004**: U.S. 400 bypass complete
Excerpts from former Secretary E. Dean Carlson’s May 1999 column

**CTP a momentous occasion**

The CTP will be the largest public works program ever undertaken in our state. The CHP proved that a good transportation infrastructure helps the economy thrive, and the CTP will continue that boost.

Getting this bill passed was not easy. As a matter of fact, up until the wrap-up session, things looked a little dicey.... But one thing that was never in question, and you should take pride in this, was KDOT’s ability to get the job done. Our credibility was never in doubt, thanks to the stunning performance of this agency in delivering the CHP on time and under budget. We may take that confidence in our abilities for granted sometimes, but we shouldn’t.

This is a perfect example of how a team lives or dies on its ability to work well together. There may have been only a handful of us at the Statehouse each day working with the legislators. But our efforts would have mattered little without the hefty reserve of credibility you have created over the years. The best lobbyists couldn’t have secured a program this size if KDOT had a reputation for promising more than it can deliver or of squandering its resources. So next time you’re wondering whether the work you do matters, believe me it does!

I appreciate it, and more importantly, the people of Kansas appreciate it.

‘KDOT is highly respected across the nation. My belief is that when you talk to companies, they say that dealing with the Kansas Department of Transportation is much better than dealing with many of the others. And what they’ve been able to do in highway maintenance and highway improvements, we’re known as a state that does it right. And that’s the way we want to keep it.’

Dave Kerr
Hutchinson Chamber of Commerce President

**CTP bill signing**

Former Gov. Bill Graves signs the CTP bill into law during a ceremony on May 10, 1999, in Paola.

---

September 2005
I-435/Antioch begins, largest project let during CTP

April 2006
Marysville Grade Separation completed

September 2006
U.S. 54/Liberal ground breaking

January 2007
K-10 Connector begins service

June 2007
Ground broken for U.S. 59

April 2008
All Kansas Air Tour 80th anniversary

June 2008
U.S. 183/Saline River Bridge construction begins

November 2008
Final I-70 section between Topeka/Salina complete

February 2009
Recovery Act provides funds for KDOT, local governments

June 30, 2009
CTP officially ends

April 2009
– Last major CTP project (K-61) let to construction
By Stan Whitley

With an entire 40-year career at KDOT in planning, Terry Heidner has unique insight into what it takes to see transportation programs come to fruition. He has witnessed successful completion of the Comprehensive Transportation Program (CTP) and its predecessor the Comprehensive Highway Program (CHP).

There are several ingredients necessary to have such programs, according to Heidner. He listed four ingredients and said they were prevalent during the CTP and CHP.

“First, you have to have a governor that is supportive and willing to spend political capital to secure a transportation funding bill and second you need one or more legislators in leadership positions that are dedicated to a transportation program,” said Heidner, who served as the Director of Planning and Development for 10 years before retiring in 2007. “You also need a DOT that is in good standing with the public and the Legislature and last you need grassroots support.”

Heidner, who came out of retirement to serve as KDOT’s Legislative Liaison the past two years, believes the 10-year CTP that is coming to an end has had a tremendous positive impact on the state.

“The economic well-being of the state has been greatly enhanced in regard to jobs and the ability to attract economic development,” said Heidner. “Also, safety benefits when you have a quality transportation system because it helps save lives. The CTP has also increased the quality of life for the public by providing a system that handles traffic efficiently and has fewer delays.”

Although both KDOT programs have been successful, Heidner said they were different. He said passage of the CTP was not as difficult as the CHP in part because the earlier program was such a huge success and was executed on time and on budget earning trust.

“I like to say that the CTP passed on the euphoria of the CHP,” said Heidner. “People could see the results and they just said give us more.”

Fighting against inflation, recessions, disasters such as Hurricane Katrina and attacks on the agency budget, Heidner said completing the CTP has been a challenge.

“There’s no question it’s been a real struggle,” said Heidner. “However, KDOT has done a great job of carrying out the program. With the help of good policies and priorities we have managed to deliver what we promised.”

Heidner said KDOT’s policy of making preservation of the existing system a high priority has served the agency well. He pointed to the state’s interstate system which has been ranked as one of the best in the nation as a perfect example.

“We are the envy of many states,” said Heidner. “We’ve had essentially 20 years of good transportation funding. Not lavish, but very adequate. That’s unprecedented in state transportation agencies.”

Mary Birch
Government Relations Coordinator,
Lathrop & Gage LLP

‘Completion of the CTP is an exciting hallmark for Kansas. Not many states have invested in a quality transportation system. The CTP has provided 10 years of construction jobs around the state as well as the long term economic impact of 28 System Enhancement projects that were completed or are under construction. The continued belief in and support of an excellent state wide transportation system will keep Kansas competitive in the world economy.’

Mary Birch

CTP funding was used to improve the Kingman Municipal Airport runway. CTP funding provided approximately $3 million each year for non-primary public use airports in Kansas.
‘I was delighted to be here in 1989 and have the opportunity to vote for the first transportation program and again pleased to be here when we did the one in ’99. Both of them have proved to be very advantageous to our state, providing many, many jobs and greatly improving the highway system that we have in our state.’

Janice Lee
State Senator

‘I recently traveled on the highways in some neighboring states. A person needs to do this to appreciate what the two highway programs have accomplished for Kansas.

The legislature had confidence the department could complete both programs. Thanks to a qualified KDOT staff and many partners, the completed programs will produce a highway system KDOT and the citizens of Kansas can be proud of.’

Warren Sick
retired Assistant Secretary/State Transportation Engineer

‘The efforts made by survey crews, utility coordinators, environmental staff, road and bridge designers and dozens of support staff to accomplish all the requirements to prepare hundreds of projects for letting and construction was outstanding. The proudest accomplishment of all the employees involved, from planning to design to construction to maintenance, was to be able to say that we did it on time and on budget without any sacrifice of quality.’

David Comstock
retired Director of Engineering and Design

A seven-year, $308 million project to construct a four-lane freeway between Fort Scott and Louisburg will be completed in July.


The $127.4 million I-435/U.S. 69 and Antioch Road project in Overland Park was the largest project ever let to contract by KDOT.
CTP Highlights

•STATE HIGHWAY SYSTEM•
  A. MAINTENANCE
  -- $123 million annual average for ongoing maintenance
  -- $167 million annual average for substantial maintenance
  B. MAJOR MODIFICATIONS
  -- $332 million annual average for projects to improve service, capacity, condition, economy or safety of the existing system and replace or rehabilitate deficient bridges
  C. SYSTEM ENHANCEMENTS
  -- $905 million for projects that substantially improve safety, relieve congestion, improve access or enhance economic development

•LOCAL PARTNERSHIPS•
  A. SPECIAL CITY AND COUNTY HIGHWAY FUND
  -- Distribution of the Motor Fuels taxes with local governments was continued and enhanced
  -- $155 million per year from the Motor Fuel Tax to the Special City and County Highway Fund
  B. FEDERAL FUNDS FOR LOCAL UNITS OF GOVERNMENT
  -- $81 million annual average (including local match) of federal aid shared with local units
  C. LOCAL PARTNERSHIP AND CITY CONNECTING LINK PROGRAMS
  -- Increased from $2,000 to $3,000 per year for the statutory per lane mile payment to cities
  -- $26 million per year average (including local match) to assist cities with City Connecting Links

•MODAL PARTNERSHIPS•
  A. RAIL SERVICE
  -- $3 million annually transferred to the Rail Service Improvement Fund is authorized for 10 years. Interest earned on this loan fund would remain with the Fund
  B. AVIATION
  -- $3 million annually transferred to the General Aviation Airport Development Fund
  C. PUBLIC TRANSIT
  -- $6 million annual transferred to the Coordinated Public Transportation Assistance Fund

“It’s always a bit risky to identify a list of projects that will be built over a 10-year period as was done in 1999. However, in spite of materials price increases and difficult state budget times, all the major projects promised are listed or under way. KDOT should be commended for the outstanding job over the last few years.”

E. Dean Carlson
former Secretary of KDOT

Construction of the U.S. 400 bypass at Dodge City, a CTP project expected to be completed in late 2009.

Former Gov. Kathleen Sebelius speaks at Louisburg in 2005 at a ceremony celebrating the first of many U.S. 69 expansion projects.

The nationally-honored I-35/87th Street project in Lenexa provided congestion relief and safety enhancements.
Number of projects       Miles         Construction Dollars
District One            1,533           4,492.35     $2,412,663,426.99
District Two            972            4,347.36        $800,562,667.76
District Three           579            3,569.56        $618,440,818.82
District Four            932            3,279.68     $1,076,058,103.86
District Five          1,225            5,456.10     $1,351,504,476.90
District Six            504            4,124.03        $505,257,298.22

“Thank goodness for the Legislature’s wisdom in passing and appropriating the money for the 1999 Comprehensive Transportation Program. It has been very rewarding to follow KDOT’s decisions in choice of deserving projects and their completion. Because of the expertise of KDOT’s leaders, employees, and contractors, all Kansans can be very proud of our highway system and the improved safety these projects bring to all drivers.”

Nancy Bogina
retired Special Assistant to the Secretary/Director of Public Affairs

“The CHP laid the foundation for the CTP. When we went to the Legislature for the CTP, there was complete acceptance for our methodology. No objections were made about the amount for Substantial Maintenance. The only real debate was how much money for Major Modification, System Enhancement and funding sources. The fact that KDOT delivered the CHP on time and under budget firmly established our credibility and ability to deliver.”

Mike Lackey
retired Assistant Secretary/State Transportation Engineer

CTP Facts and Figures

<table>
<thead>
<tr>
<th>District</th>
<th>Number of projects</th>
<th>Miles</th>
<th>Construction Dollars</th>
</tr>
</thead>
<tbody>
<tr>
<td>District One</td>
<td>1,533</td>
<td>4,492.35</td>
<td>$2,412,663,426.99</td>
</tr>
<tr>
<td>District Two</td>
<td>972</td>
<td>4,347.36</td>
<td>$800,562,667.76</td>
</tr>
<tr>
<td>District Three</td>
<td>579</td>
<td>3,569.56</td>
<td>$618,440,818.82</td>
</tr>
<tr>
<td>District Four</td>
<td>932</td>
<td>3,279.68</td>
<td>$1,076,058,103.86</td>
</tr>
<tr>
<td>District Five</td>
<td>1,225</td>
<td>5,456.10</td>
<td>$1,351,504,476.90</td>
</tr>
<tr>
<td>District Six</td>
<td>504</td>
<td>4,124.03</td>
<td>$505,257,298.22</td>
</tr>
</tbody>
</table>

Workers build the superstructure for the U.S. 183 bridge replacement project over the Saline River north of Hays.
KDOT salutes employees celebrating state anniversaries in May

Employees and home towns are included in this list.

Welcome new KDOT employees!

Headquarters
Kelley Ernst, Systems
Software Analyst III, Computer Services

Michael Lester, Utility
Worker, Support Services

William Wiley, Information Technology
Security Analyst II, Computer Services

The Bureau of Personnel
Services supplies information for new employees to Translines.

Kansas Wetland Education Center opens

The Kansas Wetlands Education Center at the Cheyenne Bottoms Wildlife Area opened for visitors during a grand opening on April 24.

Collaboration, planning, and development on the Kansas Wetlands Education Center began in 2003, after the Kansas Department of Wildlife and Parks (KDWP) received a $2 million grant for facility construction from KDOT through funds from the federal Transportation Equity Act for the 21st Century (TEA-21).

Located eight miles northeast of Great Bend on the southeast portion of Cheyenne Bottoms Wildlife Area, the Kansas Wetlands Education Center features the expansive Koch Wetlands Exhibit, which offers exhibits illustrating the natural resources of Cheyenne Bottoms and other wetlands. Exhibits provide an overview of the variety of Central Flyway wetlands, from the playa lakes of western Kansas to the flooded timber marshes of eastern Kansas. — KDWP news release

Promotions/Transfers

Headquarters
Scott Shackelford, Applications
Developer Supervisor, Computer Services

District One
Larry Eubanks, Engineering Technician Specialist, Horton

Luke Matheny, Professional Civil Engineer I, Materials and Research

The Bureau of Personnel Services supplies information for promotions/transfers to Translines.
Amtrak details stimulus projects

Amtrak has announced it will devote $1,042,200 to improvements at the six stations in Kansas serving the Southwest Chief route.

Amtrak recently released a list of capital projects to be funded by $1.3 billion from the American Recovery and Reinvestment Act (ARRA). Submitted to the Federal Railroad Administration, the list includes railcar and locomotive restoration to augment the current fleet, projects to bring stations into compliance with the Americans with Disabilities Act (ADA), facility improvements, track, bridge and signal replacements and upgrades.

The projects in Kansas include signage, platform kiosks, wheelchair lifts and platform improvements. The Kansas stations are among more than 200 stations in 40 states that will receive $40 million in needed upgrades to improve accessibility for disabled persons.

“We are very grateful that Amtrak has made this investment in Kansas,” said Secretary Deb Miller. “It’s more evidence of the strong interest in revitalizing and expanding the nation’s passenger rail system.”

According to Amtrak, more than 41,800 riders boarded and de-boarded at Kansas stations in FY 08.

A list of the Kansas Amtrak improvements are on the KDOT Web site at www.ksdot.org under Recent News Releases.

Retirees

The following employees will officially retire from KDOT in June.

Headquarters
Neil Rusch, Professional Civil Engineer II, Engineering and Design

District Five
Stephen L. Hammersmith, Engineering Technician Specialist,

Employees who choose to have retirement reception information shared on the Internet can be found at www.ksdot.org, under News and Announcements.

Don’t miss out!

KDOT

INSULATED MUGS

Big Sale!

White 22 oz. mugs with red lids feature this blue logo shown above.

To Order:
Headquarters: contact your Employees’ Council rep.
Districts/Retirees: mail completed form (or photocopy of form) and checks to: Chuck Protasio, Program/Project Management, 700 SW Harrison, 2nd floor, ESOB, Topeka, KS, 66603. Checks payable to KDOT Employees’ Council.

Get 2 mugs for just $6!

Number ordered: ________    Amount enclosed: ____________

Refills in this mug are available in the ESOB cafeteria! Refills are only 85 cents.

For more details, call Chuck at 785-296-0284
**Upcoming KDOT Training Courses**

**Classes at District Offices**
- On Second Thought – The Road to Critical Thinking: District 5, Hutchinson, May 21
- Effective Teamwork – District 1, Osage City, May 26
- You’ll Catch On: Bonner Springs, June 2, 3
- Transition to Leadership & Ethics: Salina, June 2, 3, 4
- You’ll Catch On: Salina, June 9, 10

**Classes at Headquarters**
- BEST – Week 2: May 11, 12, 13, 14, 15
- SMART – Module Session 1: June 9
- SMART – Module Session 2: June 10
- SMART – Module Session 3: June 11
- New Employee Orientation – July 9
- Basic Effective Supervisory Training – July 20 – 24
- SMART – Module Session 1: July 28
- SMART – Module Session 2: July 29
- SMART – Module Session 3: July 30

**New MindLeaders courses:**

**E-Mailing Your Way To the Top**
- (Business: Professional Development catalog)
- E-mail has become so prevalent in the workplace that we seldom think about it, and yet it is the medium coworkers see you through most often. How can your e-mails speak for you clearly, effectively, and potently? This series will walk you through building e-mail subject lines and messages that are effective and respect office etiquette. You’ll also learn about e-mail safety by avoiding threats like viruses and phishing, and how to think about e-mail confidentiality and legal security.

**Innovation in the Workplace**
- (Business: Professional Development catalog)
- Creativity can do more than just spark the next Big Idea for your organization. It’s also a critical skill for finding unique solutions to problems and new ways to improve on old processes. This series will help you to build your creativity and encourage it in others in productive ways that help your organization’s bottom line.

**Problem-Solving through Productive Thinking**
- (Business: Professional Development catalog)
- One of the greatest abilities of leaders – whether in management positions or on the front line – is the ability to see the root of problems and quickly enact effective solutions. This series will pass on some of the skills and tips that will help you to better identify problems, find their causes and get their solutions under way.